
 

 

1 

Paper SAS 4131-2020 

SAS® Grid Manager: Inside Look into Grid Launched Servers 

Murali Srinivasan, SAS Institute Inc.  

 

 

ABSTRACT  

As a SAS® Grid Manager administrator, you might wonder whether you can improve 

utilization of compute resources so that your organization has better return on investment. 

You start SAS® server processes in your grid environment by running server start-up scripts 

and through application invocation. SAS server configuration in SAS metadata determines 

how a server is launched. This paper presents best practices for instantiating SAS servers 

within a grid environment. Grid-launched servers benefit from SAS Grid Manager features 

including workload balancing, parallel processing, high availability, and flexibility with 

scaling the architecture.  

INTRODUCTION  

SAS 9.2 introduced server-side load balancing for SAS workspace servers using SAS Grid 

Manager. When a client such as SAS® Enterprise Guide® that uses this server requests a 

workspace server to run a job, the object spawner launches the server process on the best 

host, as chosen by SAS Grid Manager. SAS Grid Manager uses Platform LSF as workload 

manager to make this decision. Support for grid load balancing for stored process servers, 

pooled workspace servers, and OLAP servers was included in SAS 9.3. Support for grid-

launched servers was added starting with SAS 9.4.  

With server-side load balancing through grid-launched SAS workspace servers, when a 

client requests a workspace server, the object spawner launches the server process in the 

grid on a host based on configured SAS Grid Manager policies [1]. Client code, which is 

running as a grid job, is invoked on the workspace server. Starting with the first 

maintenance release after SAS 9.4, stored process servers and pooled workspace servers 

can also be grid-launched.  

In SAS 9.4M6, the product name for a grid using Platform LSF was changed to SAS Grid 

Manager for Platform. SAS Grid Manager product introduced a new grid provider, which 

consists of SAS® Workload Orchestrator for workload management and SAS® Job Flow 

Scheduler for enterprise scheduling. The object spawner uses SAS Workload Orchestrator 

instead of Platform LSF to start the server process. Grid-launched features are applicable to 

both SAS Grid Manager for Platform and SAS Grid Manager, and the configuration is 

identical. SAS code that runs in grid-launched servers remains unchanged with the 

introduction of SAS Grid Manager using SAS Workload Orchestrator [2]. 

CONFIGURING GRID-LAUNCHED SERVERS 

If you are deploying SAS Grid Manager for Platform, you install Platform Suite for SAS, 

which includes Platform LSF as a workload manager, prior to installing SAS software. If you 

are deploying a SAS 9.4M6 Grid Manager environment, your SAS Grid Manager installation 

includes SAS Workload Orchestrator software. Configuring server-side load balancing using 

grid-launched servers is identical to both environments. You update server definitions in 

SAS Management Console to configure grid-launched servers.  
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LOGICAL WORKSPACE SERVER 

Navigate to the Server Manager plug-in in SAS Management Console. Select a SAS 

Application Server context and convert the logical workspace server to load balancing. For 

load balancing options, specify Grid as the load balancing algorithm. Select the Launch 

Servers via Grid checkbox. This option is only applicable for workspace servers, stored 

process servers, and pooled workspace servers.  

Figure 1 shows how the logical workspace server load balancing properties for the selected 

SAS Application Server context look. 

 

Figure 1: Logical Workspace Server Load Balancing Properties 

If you are using SAS Grid Manager for Platform, add ENABLE_HOST_INTERSECTION=Y in 

the lsb.params LSF configuration file. This option prevents errors when a grid-launched 

workspace server is configured with more hosts than the HOSTS= specification in the LSF 

queue definition. 

 

LOGICAL STORED PROCESS SERVER 

Navigate to the Server Manager plug-in in SAS Management Console. Select a SAS 

Application Server context and select the logical stored process server. Select Properties 

from the Actions menu or the context menu. The Properties dialog box appears. Select 

the Load Balancing tab. For load balancing options, specify Grid as the load balancing 

algorithm. Select Launch Servers via Grid checkbox. 

Figure 2 shows how the logical stored process server load balancing properties for the 

selected SAS Application Server context look. 
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Figure 2: Logical Stored Process Server Load Balancing Properties 

 

LOGICAL POOLED WORKSPACE SERVER 

You configure the logical pooled workspace server by following the same steps as for the 

logical stored process server. 

 

Figure 3: Logical Pooled Workspace Server Load Balancing Properties 
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LOGICAL OLAP SERVER 

Grid-launched features are not applicable for OLAP servers, so the Launch Servers via 

Grid checkbox option is not available. 

 

Figure 4: Logical OLAP Server Load Balancing Options 

 

ALTERNATE CONFIGURATIONS USING LOGICAL GRID SERVER 

Alternate configurations without using grid-launched features are available to grid-enable 

SAS Enterprise Guide and SAS® Add-In for Microsoft Office clients.  

The following methods use a logical grid server definition in the server metadata to launch a 

grid server session. The object spawner starts the workspace server session. Jobs are 

submitted to the grid server session. 

CLIENT-SIDE CONFIGURATION 

SAS Enterprise Guide submits jobs to the grid if the Use grid if available option is selected 

on element properties or the project properties. To enable the grid at a project level, Select 

File -> Project Properties and click Code Submission. Select the Use grid if available 

option.   
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Figure 5: SAS Enterprise Guide Project Properties 

To enable the grid at an individual program or task level, select the properties for the 

program or task, and use the Code Submission page. Select the Use preferences from 

project properties radio button to show the current configuration from the project 

properties. Selecting Customize code submission options to override this at the element 

level.  

 

Figure 6: SAS Enterprise Guide Program Properties 
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Figure 7: SAS Enterprise Guide Task Properties 

SAS Add-In for Microsoft Office is a Component Object Model (COM) add-in to Microsoft 

Office. To grid-enable SAS Add-In for Microsoft Office, open the SAS tab from the Microsoft 

Office application on the desktop and select SAS -> Tools -> Options. In the SAS Options 

dialog box, click the Tasks tab and set the options illustrated in Figure 8. 

 

Figure 8: SAS Add-In for Microsoft Office Properties 

 

To create a grid session for initial processing, in SAS Enterprise Guide select Tools -> 

Options -> SAS Programs. In the General group, select Initialize grid (if available) 

when connecting to a workspace. This option specifies that SAS Enterprise Guide 

connects to a workspace server. It also connects to and initializes a grid server session. 

However, this option does not cause SAS Enterprise Guide to submit to the grid. SAS 

Enterprise Guide submits jobs to the grid only by selecting the Use grid if available option 
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in the element properties or project properties, or by overriding the option with the server 

metadata configuration. 

 

Figure 9: SAS Enterprise Guide Initialize Grid Properties 

 

SERVER METADATA CONFIGURATION 

You can override client-side configurations with server metadata settings if you do not want 

to allow end-user control of grid features from individual desktop applications.  

To control grid usage from server metadata, use the EGGridPolicy and AMOGridPolicy 

extended attributes on the logical grid server definition. Set EGGridPolicy and AMOGridPolicy 

to Force to always send jobs to the grid using the logical grid server definition, regardless 

of whether the Use grid if available client-side configuration option is specified. If this 

attribute is set to Noforce, whether jobs are sent to the grid depends on the value of the 

Use grid if available client-side option. If this attribute is set to Ignore, jobs are never 

sent to the grid, regardless of the value of the Use grid if available option. 
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Figure 10: Forcing Grid with Server Metadata 

In this scenario, code from the client is shipped to SAS workspace server and automatically 

wrapped with RSUBMIT/ENDRSUBMIT statements. This results in a grid server session that 

runs SAS statements within the RSUBMIT/ENDRSUBMIT block.  

IGNORING DIRECT GRID FEATURES 

Grid enabling by using one of the alternate options along with the grid-launched server 

option results, in two grid sessions, a workspace server in the grid, and an additional grid 

server session using the logical grid server definition.  

In this scenario, SASApp (the SAS Application Server context) is configured in the server 

metadata to use a grid-launched workspace server. The SASApp extended attribute 

EGGridPolicy is specified with a value of Force.  

In SAS Enterprise Guide, select SASApp from the Servers pane. Right-click and then click 

Connect. Notice that there is a tick mark and a grid symbol next to SASApp. 
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Figure 11: SAS Enterprise Guide Output 

Figure 12 is the output of the bjobs command before connecting to grid from SAS 

Enterprise Guide. There are no grid jobs for the user. 

 

Figure 12: Bjobs Output Before 

Figure 13 is the output of the bjobs command after establishing a connection to grid from 

SAS Enterprise Guide. Notice there are two grid jobs. Job 2791 is a grid-launched 

workspace server for the user. Job 2792 is an additional grid server session for the user. 

This additional grid server session is redundant and not required. Because the workspace 

server is started as a grid job, user code can directly run on the grid-launched workspace 

server.  

 

Figure 13: Bjobs Output After 

To safeguard from using both direct grid features and grid-launched features at the same 

time, you must set the EGGridPolicy and AMOGridPolicy extended attributes on the logical 

grid server definition to Ignore.  

Setting these attributes prevents SAS Enterprise Guide and SAS Add-In for Microsoft office 

from using the direct grid features and starting an additional grid server session while using 

a grid-launched workspace server. An additional grid server session is not required, because 

the workspace server is running in the grid.  

This server-side setting overrides SAS Enterprise Guide or SAS Add-In for Microsoft Office 

client-side options such as Use grid if available and Initialize grid (if available) when 
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connecting to a workspace. Jobs are always sent to the grid-launched workspace server 

regardless of the value of the option Use grid if available. 

 

 

Figure 14: Ignoring Direct Grid Features for Grid-Launched Servers 

NEWER CLIENTS 

SAS Enterprise Guide 8.2 and later and SAS Add-in for Microsoft Office 8.2 and later 

automatically ignore direct grid features when the Launch Servers via Grid checkbox is 

selected. For these clients, you do not have to set the EGGridPolicy and AMOGridPolicy 

attributes to Ignore.  

Figure 15 illustrates a grid-launched workspace server specification in server metadata. 
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Figure 15: Grid-Launched Workspace Server 

Figure 16 illustrates the extended attributes for SASApp (the SAS Application Server logical 

grid server context). EGGridPolicy and AMOGridPolicy attributes are not specified. 

 

Figure 16: Logical Grid Server Extended Attributes Properties 

Figure 17 illustrates the client-side configuration. The Use grid if available project 

property is enabled in SAS Enterprise Guide 8.2. 
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Figure 17: SAS Enterprise Guide Use Grid if Available Project Property 

Figure 18 illustrates the output of the bjobs command before establishing a grid connection 

from SAS Enterprise Guide. There are no grid jobs for the user. 

 

Figure 18: Bjobs Output Before 

Figure 19 illustrates the SAS Enterprise Guide output after running the SAS program. Notice 

a connection to SASApp with the green tick mark.  
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Figure 19: SAS Enterprise Guide Output 

Figure 20 illustrates the output of the bjobs command after running code from SAS 

Enterprise Guide. Notice that a single workspace server session has started in the grid. The 

additional, redundant, grid server session is not started. Direct grid features are 

automatically ignored while using a grid-launched workspace server.   

 

Figure 20: Bjobs Output After 

 

SAS CLIENTS AND GRID-LAUNCHED SERVERS 

You can take advantage of grid capabilities by configuring SAS clients to run SAS programs 

on the grid. Only certain SAS clients support grid-launched servers, and not all SAS servers 

can be configured as grid-launched. There are performance considerations to configuring 

certain SAS clients to use grid-launched servers.  

SAS Enterprise Guide and SAS Add-In for Microsoft Office clients should be enabled with 

grid-launched workspace servers.   

When you use server-side load balancing without selecting the Launch Servers via Grid 

option, the object spawner launches the workspace server instead of the workload manager 

(Platform LSF or SAS Workload Orchestrator). In this scenario, a grid job is not generated 

for the SAS program, and your SAS Grid Manager workload management policies such as 

job slots, queues, and CPU utilization thresholds are not in effect.  

Alternate methods that are available to grid-enable SAS Enterprise Guide and SAS Add-In 

for Microsoft Office clients launch a grid server session as well as the workspace server 

session using the logical grid server.  
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In the case of grid-launched workspace server, client code runs on a SAS workspace server 

in the grid. An additional grid server session is not required. Hence, configuring and using 

grid-launched workspace servers is more efficient and is a best practice. Client options such 

as Use grid if available and Initialize grid (if available) when connecting to a 

workspace should be ignored. This is done by setting the EGGridPolicy and AMOGridPolicy 

extended attributes to a value of Ignore in server metadata. 

It is a best practice to configure SAS® Studio Enterprise Edition to use grid launched 

workspace servers in the same way as SAS Enterprise Guide. SAS code runs on SAS 

workspace server in the grid. An alternate approach is to use SAS/CONNECT 

GRDSVC_ENABLE, SIGNON, and RSUBMIT functions in a SAS code to submit to the grid for 

processing. In this scenario, a SAS workspace server and an additional grid server session 

are required to run your SAS code on the grid. You can avoid the overhead of grid enabling 

your SAS code when using grid-launched workspace servers.   

You can benefit from a grid-launched workspace server configuration for SAS® Enterprise 

Miner™ 14.2 client. If you are using a version of SAS Enterprise Miner prior to 14.2, 

configure the object spawner instead of Platform LSF in order to start SAS workspace 

servers.  

SAS Grid Manager Client Utility (SASGSUB) does not use grid-launched servers. When you 

submit a SAS program to the grid using SASGSUB, LSF runs a sasgrid script that starts SAS 

in batch mode. This grid command is defined in the Grid Server Properties dialog box in 

server metadata. Grid-launched servers are applicable only to SAS IOM servers such as SAS 

workspace servers, SAS stored process servers and SAS pooled workspace servers.   

VALIDATIONS 

GRID-LAUNCHED WORKSPACE SERVER VALIDATION 

Navigate to the Server Manager plug-in in SAS Management Console. Select a SAS 

Application Server context that is configured with grid-launched workspace server. Select 

the logical workspace server, right-click, and select Validate. 

You should see the message box illustrated in Figure 21, with a Validation Successful 

message. Click the Details button to view more information about the validation.  
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Figure 21: Validate Grid-Launched Workspace Server 

The validation action causes the object spawner to start a workspace server as a grid job 

using Platform LSF and the SAS Management Console Java client to establish a successful 

connection to the server. A PROC OPTIONS program is submitted to the workspace server 

session.  

You can verify the grid job by using either the SAS Grid Manager for Platform module for 

SAS Environment Manager or a command-line interface. Figure 22 illustrates the bjobs 

output before the Validate action. 

 

Figure 22: Bjobs Output Before Validate 

Figure 23 illustrates the bjobs output after the Validate action. Notice the presence of a 

new job with a job id of 2764, a job name *_SASApp_WorkspaceServer_*, and a status of 

DONE for the user who ran the Validate action. 

 

Figure 23: Bjobs Output After Validate 

A workspace server was started as a grid job to perform the validation. The grid job ends 

after validation. 

GRID-LAUNCHED STORED PROCESS SERVER VALIDATION 

Navigate to the Server Manager plug-in in SAS Management Console. Select a SAS 

Application Server context that is configured with a grid-launched stored process server. 

Select the logical stored process server, right-click, and the select Validate. 
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You should see the message box in Figure 24 with a Validation Successful message. Click 

the Details button for more information about the validation.  

 

Figure 24: Validate Grid-Launched Stored Process Server 

You can verify the grid job using either the SAS Grid Manager for Platform module for SAS 

Environment Manager or a command-line interface. Figure 25 illustrates the bjobs output 

before the Validate action. Notice there are no stored process server grid jobs.  

 

Figure 25: Bjobs Output Before Validate 

Figure 26 illustrates the bjobs output after the Validate action. Notice the presence of a 

new job with job id of 2765, a job name of *_SASApp – Stored Process Server_*, and a 

status of RUN for the sassrv user. The stored process server runs under the sassrv user 

account. 

 

Figure 26: Bjobs Output After Validate 

A stored process server was started as a grid job to perform the validation. The grid job 

continues to RUN to process subsequent stored process server client requests after 

validation. If required, additional stored process server grid jobs are launched based on load 

balancing properties and the number of client requests. 
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GRID-LAUNCHED POOLED WORKSPACE SERVER VALIDATION 

Navigate to the Server Manager plug-in in SAS Management Console. Select a SAS 

Application Server context configured with a grid-launched stored process server. Select the 

logical pooled workspace server, right-click, and select Validate. 

You should see the message box illustrated in Figure 27 with a Validation Successful 

message. Click the Details button.  

 

Figure 27: Validate Grid-Launched Pooled Workspace Server 

You can verify the grid job using either the SAS Grid Manager for Platform module for SAS 

Environment Manager or a command-line interface. Figure 28 illustrates the bjobs output 

before the Validate action. Notice there are no pooled workspace server grid jobs.  

 

Figure 28: Bjobs Output Before Validate 

Figure 29 illustrates the bjobs output after the Validate action. Notice the presence of a 

new job with job id of 2766, a job name of *_SASApp – Pooled Workspace Server_*, and a 

status of RUN for the sassrv user. The pooled workspace server runs under the sassrv user 

account. 

 

Figure 29: Bjobs Output After Validate 
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A pooled workspace server was started as a grid job to perform the validation. The grid job 

continues to RUN to process subsequent pooled workspace server client requests after 

validation. Creation of subsequent grid jobs is dependent on server-side pooling properties 

and the number of client requests. 

SAS ENTERPRISE GUIDE VALIDATION 

Launch SAS Enterprise Guide and check the bjobs output. Notice there are no grid jobs, as 

shown in Figure 30. 

 

Figure 30: Bjobs Output Before Validate 

Navigate to the Servers pane, right-click SASApp (the SAS Application Server context) and 

click Connect. 

 

Figure 31: SAS Enterprise Guide SASApp Connect 

You can verify the grid job using either the SAS Grid Manager module for SAS Environment 

Manager or a command-line interface. Figure 32 illustrates the bjobs output after the 

Connect action. A workspace server is started as a grid job on behalf of the user. The grid 

job continues to RUN to process subsequent requests from the connected SAS Enterprise 

Guide client. Any SAS program or task invoked from the same client application runs on the 

same workspace server session in the grid. 

 

Figure 32: Bjobs Output After Validate 
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Figure 33: SAS Enterprise Guide PROC OPTIONS Output 

 

GRID-LAUNCHED VS NO GRID-LAUNCHED 

You can use SAS Enterprise Guide to compare the results from running with a grid-launched 

workspace server configuration to an alternate configuration that does not use a grid-

launched workspace server. 

Figure 34 illustrates the detailed bjobs output when using a grid-launched workspace 

server. Job 2777 is a workspace server session started by the object spawner, using LSF for 

the user. Code submitted from SAS Enterprise Guide runs directly on this session as a grid 

job.  



20 

 

Figure 34: SAS Enterprise Guide Bjobs Detailed Output with Grid-Launched Server 

Figure 35 illustrates the detailed bjobs output from using the Use grid if available client-

side configuration while not using grid-launched server features in server metadata. The 

object spawner starts a workspace server session that is not a grid job. Job 2774 is a grid 

server session for the user started by LSF using the sasgrid script. Code submitted from 

SAS Enterprise Guide runs on this session as a grid job. 
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Figure 35: SAS Enterprise Guide Bjobs Detailed Output without Grid-Launched Server 

CONCLUSION 

There is a cost associated with starting a workspace server and a grid server for every user 

request to run a grid job. Grid-launched servers start server sessions in the grid. An 

additional grid server session is not required. It is efficient to run code directly on the grid-

launched workspace server. There are cases when you do not want to use grid-launched 

server features. For example, some SAS web applications might perform better using 

server-side grid load balancing and enabling the object spawner instead of the workload 

manager to start the SAS server. In this scenario, LSF is used to select the best host to 

start the SAS session, but the workload is not managed by LSF policies, because there is no 

grid job. 
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